Terminology: for incoming e-mail: POP=Post Office Protocol, IMAP=Internet Message Access
Protocol not offered by most Internet Service Providers, but a free Gmail account offers it. AOL
accounts also work this way. E-mail stays on server, not your Mac. Outgoing e-mail: SMTP=Simple
Mail Transfer Protocol. Mailbox is like folders for each account, typically you will have an inbox,
drafts and a sent or sent items and perhaps a trash and a Spam folder. When you are actively sending
mail, there would be a temporary outbox.
Basic Theory: You send a mail message to your ISP’s SMTP server, which then sends that to the
recipient’s mail server where it waits for them to receive it. If their account is filled with mail, your
message will get bounced back, probably with an over quota message. When they receive it and reply,
it’s sent to your ISP’s POP server, waiting for you to retrieve it. Generally with a POP type account,
your software should be configured to immediately remove the message off their server so mail does
not pile up on the server, just in your inbox. E-mail programs are usually configured to periodically
check for new messages. With an IMAP style account, the mail stays on the server and not removed
unless you delete it. This style account is preferred if you need to check the mail and peruse the whole
collection from more than one computer or mobile device. There is a third common mail protocol,
called MAPI/RPC used in many offices with a Microsoft Exchange server and Outlook clients. In
conjunction with Outlook Web App (formerly Outlook Web Access), Macintosh and iOS clients (and
any web browser) can access these systems, generally in a limited fashion. Generally there is
password authentication on the incoming mail server (POP or IMAP) and increasingly the SMTP
servers require it too.
Viewer Window: Top customizable Toolbar with search field – collapsible, sidebar on left with
mailboxes, with disclosure triangles along left edge to hide stuff. The sidebar can be resized. File
Menu - New Viewer Window for a second window showing a different mailbox’s contents. Mail will
remember on next launch to open two windows.
----------------------------------------------------------------------MAILBOXES: Inbox with indented inboxes for each account. Master Inbox shows combined inbox of
all accounts. Likewise, you’ll find unsent Drafts and your Sent mailbox(s). There are the Trash boxes.
Generally I like to have Mail empty the Trash when I quit. This is set in the Preferences – Accounts.
For each account, click on the Mailbox Behaviors where I check the option to Move deleted messages
to the Trash mailbox and for ‘Permanently erase deleted messaged when:’ I select ‘Quitting Mail’
SMART MAILBOXES section contains dynamic mailboxes analogous to the Finder’s Smart Folders.
It’s a saved search. The most common use is to collect the messages from a single sender, but it could
collect all messages containing some keyword, either in the inbox as well as sent messages.
REMINDERS section includes Notes, which sync with the Notes app on the iPhone, iPad or iPod
touch if that option in iTunes was checked. On the iPhone they are shown in reverse chronological
order. Create a new note from the File menu – New Note. The first line of the note becomes the title
and shows up in bold in your Inbox. You can apply fonts to your note text, but since the iPhone has a
limited selection, not with much accuracy. You can apply colors and that’s kept. Font size is kept, but
the line spacing is fixed, so don’t go too big.
RSS, which stands for Really Simple Syndication shows the subscribed-to news, by default just
Apple’s. You can use Add RSS Feeds… from the File menu, or the plus sign at the bottom-left of the
window. Some only work if you check the box for show in inbox. If you click on a RSS feed and see
an up-arrow next to the RSS unread headlines count, clicking on it will move the updates to the inbox.

Don’t worry; it’s reversible. Each news item, often several per day, is shown as a one-line summary,
with a Read more… link. Clicking that will bring up the whole article in Safari (assuming Safari is
your default web browser.) If you want to stop the flow or slow the flow of RSS headlines, go to Mail
menu – Preferences… - RSS and change the Check for updates to Manually to shut them down or
perhaps ‘Every day.’
ON MY MAC section is alphabetical. If you import mail from another source or created a new
mailbox, it would show up here. When you create a New Mailbox, you can select where in the
hierarchy to place the new folder. If you select an existing folder and use the hierarchical menu, the
new mailbox will default to being inside the selected mailbox. I often create a rule to move mail into
sub-folders, and we will get to rules later.
IMAP folders by account: Below the ON MY MAC section, you can find the assorted mailboxes
besides the inbox for your IMAP style accounts, like Gmail and AOL. It’s likely these folders for the
IMAP account were created on the Gmail web site.
The number shown in the sidebar for each mailbox or folder shows the unread count. The total
number of messages for a selected mailbox or folder is shown next to the name in the title bar. At the
bottom of the sidebar is a group of 3 buttons; the first a plus sign creates new regular mailboxes or
smart mailboxes, the second shows or hides the Mail Activity pane and the third has other useful
commands for existing mailboxes. I usually use the right-click to access this contextual menu. One of
the unknown useful items there is Get Account Info window – Quota Limits. If you select an IMAP
account like Gmail or AOL, it will total up the amount of space your mail is taking up on the server,
with a breakdown for each mailbox. The other daily useful command in this menu is Erase Deleted
Items… to actually purge all the stuff you’ve thrown out.
----------------------------------------------------------------------The main portion of the Viewer window is broken into two panes. The top or only pane holds the
selected (in the sidebar) mailbox’s list view of the mail and perhaps notes and RSS feeds. Below that
is the optional preview pane, which Mail calls the message area. When you click on a particular email, it is auto-opened in the preview pane. The pane-split bar can be double-clicked to hide/reveal or
dragged to resize. While the preview pane is convenient, it could be very bad as well. You can’t delete
an e-mail without first auto-opening it unless you delete a batch and then retrieve the balance from the
Trash. Most folks wouldn’t think of that trick. You could have received a malicious or malformed
message which can cause the application to crash as it’s viewed or it could have embedded code
which confirms your e-mail address to a spammer. The safe way to work is to shrink the preview pane
to nothing and then you would have to double-click a message in order to read it in another window.
The interesting things happen right there in the column headings, some of which are obvious and some
have arcane tiny icons. The headings are like those of the Finder, you can re-order them and resize
their widths. Note on the selected column header, there is the sort order indicator. The most popular
setting would be to select and thus sort on the Date Sent or Date Received column, with the arrow
pointing down so that the most recent message is at the top of the list. You can control which columns
are shown, by going to the View menu, Columns – then selecting from the hierarchical choices. The
checked items are shown, not necessarily in the order shown in the menu. I prefer the Date Sent to
Date Received, but the point could be argued either way. I also add the Flags column, to help mark a
message for follow-up. The columns selection in Mail is the same for all mailboxes, which is different

than the way Microsoft Entourage does things. It’s kind of a shame, though, as I want to see ‘From’ in
my Inbox but ‘To’ in my Sent mailbox. There is a column with a paper clip for attachments.
If a message has attached files, there will be a paper clip and the number of attached files.
It’s fairly obvious for just an icon. The mystery three columns can be deduced after you use
Mail a while. The column with a small round dot in the header shows what emails have been
read, no mystery as the blue dot next to a email goes away as soon as it’s read, which is
instantly after you click on it when you have the message area visible. If you reply to the
message, then a curly gray arrow appears in this column. If instead you forwarded this message, then
you will see an arrow pointing to the right. These same marks are used on the iPhone’s mail app. If
you redirected a message, which is like forwarding but with the original sender in the ‘From’ field,
then you would see a jagged arrow. If you sort the list by this column, unread mail is first, then
replies, then forwarded messages and finally redirected messages. If you click on the little forwarded
or replied flag symbol, it will show you the sent mail in a new window. There is the flag icon column
for messages that have been purposefully marked to be flagged. In this column, if you have the junk
mail filter tuned on, you could see a little brown bag icon in this column for a message flagged as
junk. If you received a message with a priority, you could see a pair of exclamation marks in this
column. The last icon header is the ‘Available for chat’ column. If you have iChat running at the same
time as Mail, and a sender is online and available, all the messages from them will have a bright green
dot indicating this. This enables the Reply with iChat item in the Message menu. If you have
customized the toolbar at the top of the viewer window, the Chat icon would be enabled with
something akin to the iChat blue icon. Clicking it would bring up a text chat window to that sender.
Getting back to the junk mail, in the Preferences, there is the option, on by default, for filtering out
junk mail, by flagging suspects as junk. The messages flagged as junk can be marked as junk and left
in the inbox or moved to a separate mailbox. Sure you can click the Not Junk button, but that affects
just this one message. The best way to keep real mail from known senders out of the junk mail group
is to add the sender to your address book. This common task is available from the message menu, but
for people who have resisted doing so up till now, it’s worth remembering the keyboard shortcut,
command-shift-y. The address book is actually managed with a separate program Address Book, but
you can view but not edit the list from the Window menu Address Panel. This panel auto hides when
Mail is no longer the current application. Related to the address book list is the list of Previous
Recipients, also found under the Window. This is the tricky bit; this list is not edited by efforts in the
Address Book application. If a friend has changed their e-mail address, and you went through the
trouble of adding their new address to the Address Book and then even went into Address Book and
removed their old e-mail entry, if you typed their name into the ‘To’ field of a new message, it’s likely
to use their old e-mail address. To fix this you need to take the additional step of removing their old email entry from the Previous Recipients list, as this is the list Mail uses to auto-complete as you type
in a person’s name. As a helper, notice that the Previous Recipients window shows the last time you
sent a message to each address. Notice also the gray icon at the left of at least some of the entries
there. If a previous recipient is in the address book, it will have the icon. If you have been sending out
a bunch of messages and have not yet been adding them to your address book, here is a great way to
fix that. There is an Add to Address Book button right there. In fact you can sort on the ‘in address
book’ column, finding the entries lacking below the ones in the address book and selecting a whole
bunch and adding them en masse.

If you created a new mailbox on your Mac, one of the most useful functions of Mail is to create a rule
to help populate it automatically. Found in Preferences… Rules, you click on the Add Rule button and
you get a new slide down panel. You first give this rule a useful name in the Description field. If you
had a specific message highlighted first, the “If any” condition defaults to ‘Any Recipient contains’
this e-mail address and the action is ‘move the message to mailbox’ and you have to use the pop-up
menu to select your new mailbox. This will take any incoming mail out of the inbox and put it in the
new mailbox. You can create a series of mailbox and rules, which will auto-fill with that person’s
messages. I suggest you create a mailbox for suspicious senders, where the rule is If any ‘Sender is not
in my Address Book’, move to this suspect folder. That should keep your mailbox free of
advertisements. You keep real mail out of this suspect mailbox by adding a sample sender to the
Address Book. You can build more complicated criteria by adding another condition by clicking the
plus sign to the right of the first condition and perhaps changing ‘any’ to ‘all’. You can also make the
conditions intentionally vague. Say you don’t know anyone in Russia, so the condition could be
‘From’ ‘contains’ ‘.ru’ which is the top level domain for Russian web sites and ISPs. The action could
be to ‘Delete Message’ right away. This is very useful if you keep getting junk mail from slightly
different addresses. One of the little tricks is to make an action of Play Sound when a specific sender
or the Message Content contains some important word. This way, you will be specifically alerted
when the important mail comes in. You can add more custom sounds if you have them in .aif format.
Keep the sound bite short; I’d say 3 seconds tops. Put them in the ~/Library/Sounds/ folder. Mail will
process your incoming e-mail in the displayed order of the defined rules, so you may need to drag to
re-order them in the Rules Preference window.
Messages with the same subject as the current one will be highlighted in light blue, regardless of the
System Preferences – Appearance highlight color. This helps you follow a conversation thread.
Besides juggling the sort order, there is a new option, for following your messages in a threaded
manner, not just linear. I like to add the Threads icon to the top toolbar. You can also use the View
menu to Organize by Thread. It’s often valuable to show a mailbox in threaded view. Messages with
the same subject, not counting ‘Re: ’ in front, are indented below the first one, which would be the
newest one assuming sorted by date. You can collapse a thread to hide the older messages. There
would be a disclosure triangle in the new column on the left. You can use the left and right cursor keys
on your keyboard to toggle the thread’s visibility. You can have one mailbox in threaded view and
another in a non-threaded, old school view. If you click on a closed thread with the preview pane
visible, it will show the thread subject, who started the thread and the messages in the mailbox. And
there’s the rub, the limitation of the threaded view, still only shows one side of the conversation, the
inbox for example. The new Microsoft Outlook from Microsoft’s Office for Mac 2011 can show both
sides of an e-mail conversation.
All of this is depending on setting up the Account(s) correctly in the Preferences. Most folks will have
a POP account with optimum online or Verizon DSL of FiOS. The Mailbox Behaviors tab for Trash
should show a check for ‘Move deleted messages to the Trash mailbox’ and Permanently erase deleted
messages when ‘Quitting Mail’ so your local collection of mail doesn’t get too big. What is more
important is the Advanced tab, where you should have ‘Remove copy from server after retrieving a
message:’ is checked and the pop-up should show ‘Immediately’ otherwise mail that shows up in your
Inbox is not removed off the ISP’s mail server, filling up your allocated space. If you get a lot of mail,
it could fill up in less than a week, and preventing anyone from sending you any more messages. They
would quickly get an obscure error message from their mail server. If you have additional e-mail

accounts, Optimum Online like most ISPs don’t want to forward other companies emails through their
SMTP server, so they want you to use their server for all your outgoing mail, regardless of the reply to
address. For this reason they have been adopting a more secure method. If you look in your Account
Information tab, there is the name you assigned to the Outgoing Mail Server. The name is not
important but the settings sure are. Click on the name, it’s a pop-up menu and select Edit SMTP
Server List… The Server Name should be OK at mail.optonline.net, so change to the ‘Advanced’ tab
and change the Authentication: to ‘Password’ and put in your User Name and Password. If you want
to particular, you can choose the Use custom port option and explicitly specify port 587.
Macs have very few viruses to worry about but you could get a phishing scam in a bogus email,
disguised to be from your bank or eBay. There is an easy way to check these out. There is usually a
link to follow in the HTML formatted message. If you just hover your cursor over the link, your
cursor becomes a gloved hand and a yellow info flag shows with the actual URL the link would
follow. If it’s not in fact the bank’s URL or eBay.com or whatever it’s pretending to be, delete the
message immediately or forward it to their fraud prevention email address to report the sender.
Search and Find – Not the same in Mail. The Search field in the toolbar is like Spotlight field in the
Finder. It starts searching as you type. Unfortunately, regardless of whether you were looking at the
Inbox or the Sent, it defaults to searching all your mailboxes and searching for matches in the ‘From’
line. Unlike the Finder, you can’t add additional criteria to narrow the search. You can go to a more
general search by switching to ‘Entire Message’ The Find function, as part of a Find and Replace
dialog box, applies to the body of a single message.
So now that we can send and receive mail sitting on the server, lets talk about composing a new
message. Try to avoid the caps lock when typing a new or reply message; it’s considered shouting.
Preferences – Composing – Check spelling ‘as I type.’ Misspelled works are highlighted by a red
dotted underline. You can add to this, including grammar checking, by going to the Edit menu –
Spelling and Grammar – Check Grammar with Spelling. Any error will be shown with a green dotted
underline. If you compose a message including copying and pasting in a URL from a web browser or
elsewhere, sometimes the URL can be very long. If it’s longer than 80 characters, Mail will try to
word wrap the text onto a second (or more) line, which will break the link to the desired page. To
avoid this, type a open angle bracket < before the URL and a closing > bracket afterward. Even a
multi-line URL will work fine at the receiver’s end. One of the best ways of getting the URL into Mail
is to use the Mail Link to This Page command from Safari’s File menu.
So maybe we want to or need to dress up a plain text message. Most business folks will add a
signature block at the bottom of every message and they are not copy and pasting it in each time.
While the name may be misleading, these text blocks are called signatures and you can have a
different one for each mail account. Go to Mail – Preferences – Signatures. Click on a mail account
and click on the plus sign at the bottom of the middle column. You’ll get a generic title for this
signature and the signature will be two lines; your name and your e-mail address. You can change the
size, style, font, and color of the text. Drag in a small photo or logo. Don’t get too fancy with an
animated GIF or video. You can copy and paste in elements from a web site, which is great for
bringing in a rule to separate the signature block from the body of the message. It’s been suggested to
include tiny icons for facebook, twitter etc. and make these links to your web pages. If someone prints
an email from you, this signature would be included and this would dress it up.

The next thing folks tend to want to do is attach a photograph they took. On the assumption, it’s in
iPhoto or Aperture, Mail makes this easy. Just click on the Photo Browser button in the compose
window’s Toolbar, scroll down to the appropriate album, and click on it. You’ll then see thumbnails
of the images therein. If you right-click in the Photo Browser window, you can switch to viewing as a
list, which gives you a date column. Just drag into your message, the image or images you want. You
can filter the displayed choices with the search field at the bottom of the window. Notice that the
magnifying glass symbol is a pop-up menu, where you can change to searching by keyword or number
of stars you awarded each image in iPhoto. If you select Faces or Events and drag into your message,
you may get more than one image, but the cursor will show the image count as you drag.
Unfortunately dragging a place will not reveal how many pictures will come along, so be careful. If
you first highlight a place, the image count will show at the bottom-right of the Photo Browser
window. If your camera shoots videos and they are in iPhoto, you can bring them in too. There is a
play button at the lower-left to review them. If iPhoto is running, you can just drag an image from
iPhoto’s window into your message window in Mail. Keep an eye on the Message Size info at the
bottom of your compose window, as the total must be under 7 MB. Highlighting an image in the
window, you can down-sample the image to Small, Medium or Large to save space. iPhoto before
version 9 from iLife 2011 offered a way to push the images from iPhoto into an attachment. Now with
iPhoto 9.1, it wants to attach them as part of a fancy formatted template. It’s too cutesy for business
use, in my opinion.
Show Stationary button in the toolbar is sort of like this new template based function in iPhoto 9.x.
You can invoke this before or after you start typing a message. If you do it before, then Mail puts in
sample formatted text. If you do it after, the already typed text is put into the graphic layout. First
select Signature None if you have one (if you don’t then the signature gets in the way) then click on
the Show Stationary button, then scroll and select a category on the left and then click on a template.
Besides the backdrop there is often one or more image drop zones. You can drag and drop a photo
from iPhoto on top of the sample images or use the Photo browser. Once you drop in an image, you
can’t play with it within the template. The image is scaled to fit and that’s it. If you would like more
stationary templates, check out http://www.equinux.com/us/products/stationery/index.html
Finally we come to the general case of attaching arbitrary files from the Finder. Just drag them in. As
before with photos, keep the total message size down below 7 MB. You have to add up the shown file
sizes. A warning about filenames: The person you are sending these files to may be running Windows,
so your files must have the proper file name extension if you expect the open the files. Mac OS can
use old school Finder extended attributes like type and creator codes, but Windows only knows about
file names. Observe the usual standards, like .txt for plain text, .rtf for formatted text, .doc for older
Microsoft Word files. Sometimes it helps to create an .zip-compressed archive (Finder File menu) of
the files you want to send and send that instead.
If someone sends you an interesting message and you wish to forward it to someone else, don’t just
address and send, you can edit the message first. Trim the fat! If it’s HTML formatted you can select
regions and delete them with the x in the circle at the beginning of that block. The same thing if you
send the contents of a web page from Safari. You can manually trim out the
From/Date/To/Subject/Reply-To block(s) and signature area at the bottom. In the body, select the text
and go to the Format menu and select Quote Level – Decrease, which is command-option-quote which

may need to be followed up with Format menu – Indentation – Decrease, which is command-left
square bracket. One of the most interesting things is when you use the Mail Contents of This Page
item from Safari’s File menu. You can then trim out the distracting parts and leave the interesting
parts in the final message you send out.
When there is trouble sending or receiving mail, check out of the Window menu - Activity to get
better idea of what is happening. Sometimes when you can’t get mail, it’s because the stored password
has become corrupted and you need to use Keychain Access application from the /Applications/
Utilities folder
For further reading, I suggest you check out chapter 19 of Mac OS X Snow Leopard, The Missing
Manual.

